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Introduction

The present document includes both PRIMORIS — Reviewer’s Paper Assignment User and Reference

Manuals.

In the User Manual you will find a step by step guide on how to execute the papers assignment to
reviewers.

The User Manual is intended to guide you along the main functionalities normally used to accomplish
this task quickly and easily.

In the Reference Manual you will find a detailed description of each page and functionality provided
by PRIMORIS — Reviewer’s Paper Assignment.

The Reference Manual is primary intended to allow the Chair to check if some required functionality
is available, where it may be found and how to use the provided functionality to achieve the task.

INSTICC hope you will find these manuals useful to help you with your task; nevertheless, we would
very much appreciate if you could send us your feedback about these manuals and about the
PRIMORIS system itself directly to secretariat@insticc.org so that we can consider them in future

updates and revisions.
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Conventions and Notation

Notice that, throughout all these manuals, some described functionalities, buttons or tabs may not
be available depending on the phase you are dealing with.

Chapters of both manuals as well as figures along both manuals are enumerated sequentially along
one single list, in order to simplify your browsing and referencing.

NOTE: The following sections are intended to help you reading
the manuals in a clear and straightforward way. You do not
need to read them in order to achieve your tasks but they may
help you browsing the manuals.

In The User Manual

Main tasks, the ones that may require several steps in order to be achieved, are numbered as shown
in Figure 1.

1 Example of Main Task enumeration

Figure 1

Sub tasks are numbered as shown in Figure 2 and makes sense only inside the Main Task.

1.1 Example of Sub task enumeration

Figure 2

All steps required to achieve all the tasks are sequentially numbered in one single numbered list
throughout all the User Manual and aligned left, as shown in Figure 3, so that your eyes may follow it
without bothering with ‘NOTE’s and explanations.

1 First step
2. Second step
3. Third Step.

Figure 3

Explanations are right aligned and marked as a ‘NOTE’ as shown in Figure 4 so that you may disregard
them if you just want to follow the steps.

NOTE: This is an explanation about where you are or what are
you doing.

Figure 4

Relevant Explanations that should be clearly noticed are left aligned and marked as a ‘RELEVANT
NOTE’ as shown in Figure 5 so that you see them even if you just want to follow the steps.
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RELEVANT NOTE: This is a relevant note about the
steps that should be executed.

Figure 5
In The Reference Manual

The content of PRIMORIS Main pages, those that aggregate several functionalities are enumerated as
shown in Figure 1.

The content of secondary pages, tabs and separators are numbered as shown in Figure 2.

Explanations are right aligned and marked as ‘NOTE’, as shown in Figure 4 so that you may disregard
them if you just want to find some relevant topic or keyword.

Relevant Explanations that should be clearly noticed are left aligned and marked as a ‘RELEVANT
NOTE’ as shown in Figure 5.
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In this User Manual you will find a step by step guidance on how to execute the reviewer’s paper
assignment procedure.
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1 Start Window

1. Double click on the shortcut to Primoris — RPA in your desktop and a new window will

pop up (Figure 1.1).

85 primoris - Canference Management System

PRIIOIDRIE

CONFERENCE MANAGEMENT SYST=EM

‘Wark Offline ‘Wark Online

Username | Enter your Username

Password Enter a Password

[JRemember me

Choose File

p—

Figure 1.1 PRIMORIS — RPA Welcome window.

2. If you have received the file containing the pre-distribution from the secretariat then go
to the offline mode (left side — work offline) and to Section 3 of this manual, otherwise
go to the next step.

3. If no file was received from the secretariat then you should go to the online mode (right
side — work online) and to Section 2 of this manual — available only for the Program
Chair.
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2 Logging in — Online Mode

4. Type in your username and password using the ‘Work Online’ frame.
5. Press the ‘Login’ button to validate your credentials and you’ll be redirected to Section 2.1
(Figure 2.2).

NOTE: If the username or password are incorrect,
an error message will be shown.

85 primoris - Canference Management System =X

PRIQDRIE

CONFERENCE MANAGEMENT SYST=M

‘Wark Offline ‘Wark Online

Username | Example@insticc.org

Choose File Password |mwesmavaneas |

[JRemember me

pm—

Figure 2.1 PRIMORIS — RPA Welcome window.

2.1 Load Event

6. Once logged in you should choose the role ‘Program Chair’ and the corresponding Event.
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o Primaris - Conference Ma nagement System -

Welcome jteixeira@insticc.org

|Choose Event

Role -

Event - Download

Files Awaiting for Submission

Event Mame Downloaded at Download will expire in Submit Delete

Downloaded Events

Event Mame Downloaded at Download will expire in . Unlock Event

Figure 2.2 Online Mode — Roles.

7. Once having selected the role and event press the ‘Load Event’ button.
8. The system will now ask you to save the event on your computer. After this step you go to

Section 4.
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3 Working with the Offline Mode

3.1 Loading an Event File

9. Press the ‘Choose File’ button to choose the file which contains all the information about the
event.

85 primoris - Canference Management System =X

PRIQDRIS

CONFERENCE MANAGEMENT SYST=EM

‘Wark Offline ‘Wark Online

Username | Enter your Username

Choose File Password | Enter a Password
[JRemember me

—:a—

Figure 3.1 Offline Mode - Start Window.

NOTE: You can only choose Zipped files (*.zip)

10. After choosing the file, a message in red will appear (as in Figure 3.2) and you should then
click on the ‘Load Event’ button (Figure 3.3). Once the file is loaded you will be redirected to:
a. If you are acting as a Program Chair then you’ll be redirected to Section 4 otherwise
go to the next step.
b. If you are acting as an Area Chair then you’ll be redirected to Section 5.

Work Offline Waork Offline

hepseiie | | osdbrent Choose File Load Event

File selected: 555z
ile s P File selected: 555zip

Figure 3.2 Offline Mode — Chosen File. Figure 3.3 Offline Mode — Load Event.
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4 Automatic Distribution

This window is divided in three different areas:

e Automatic Papers Assignment — where you can read information about the working
event and adjust the parameters to a new Automatic Distribution;

e Exclusively Automatic Distribution — where you can start a new Automatic
Distribution and proceed to Manual Reviews Distribution;

e Ignore Automatic Distribution and do Manual Distribution — where you can proceed
to Manual Distribution without taking into consideration the Automatic Distribution
and its parameters.

11. If no distribution was done (no file was sent by the secretariat) then you should adjust the
parameters to start a new automatic distribution (see section 11). Use the following
parameter intervals:

a. Reviews Number: from 2 to 5 reviews per paper (Suggestion: 4);
b. Minimal Match %: no less than 25% (Suggestion: 35%);
c. Extra Reviews: No more than 2 extra reviews per reviewer (Suggestion: 0).

85 primoris - Canference Management System - =2 X

Automatic Papers Assignment

Reviews Number 2

Minimal Match (%) 30

Extra Reviews 0 58 Papers already distributed to 63 Reviewers
Originating a tatal of 123 assignments

Paper Type (O Regular () Position (@) Regular = Position

Exclusively Automatic Distribution Ignore Automatic Distributionand do Manual Distribution

<@ o o

Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

Figure 4.1 Distribution Window.

12. Once the parameters are adjusted click on the ‘Start Distribution’ option (Figure 4.1);
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Start Distribution

Figure 4.1: Start Distribution

13. Once the automatic distribution is complete you’ll receive a report informing with its results
and the ‘Manual Reviews Distribution’ button will be made available (Figure 4.2).

Exclusively Automatic Distribution Ignore Automatic Distributionand do Manual Distribution

Jw| [0 o

Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

Time Elapsed: 2,633 (Seconds)

Figure 4.2 Distribution Window — Distribution Report.

14. If you are satisfied with the results obtained from the automatic distribution you can click
the ‘Manual Reviews Distribution’ button to proceed to manual distribution at Section 5,
otherwise go back to step 11 or if you wish to ignore the automatic distribution go to next
step.

15. Having decided not to use the automatic distribution, or disregarding any distribution
already done, you should click on the option ‘Exclusively Manual Distribution’. You'll be
redirected to Section 5.
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5 Manual Distribution

5.1

Assigning and Unassigning Papers to Reviewers

16. To assign a paper to a reviewer you must click on the intersection checkbox (Figure 5.1) and

17.

18.

the checkbox will be validated and its color will change according to the specification of the
assignment. The respective reviewer and paper counters will be incremented. Information
about the colors can be found at Section 7.

To unassign a paper to a reviewer you must, again, click on the intersection checkbox. The
color will change and the respective counters will decrement.

Perform steps 16 and 17 until you’re happy with the current paper assignment and go to
Section 6.

NOTE: When you make an assighment and the maximum
number of reviews defined by the reviewer is reached, you
will get a message asking you to confirm the assignment.
Pressing ‘Yes’ the paper will be assigned to the reviewer.

NOTE RELEVANT: During the assignment process
filters may be used. Check Section 7 for more details.

85 primoris - Canference Management System =X
Redistribute  Validation ~ Options  Help [ Notifications
Assignments £
F i z 5 g z = = = : : 3 z g g . o
B g E 5 = = H = 5 g = : s E S S =
= ] a i & E = z = By 2 =) oy E g
&N o [2 1 afo[afz2|s[z2]3eo|s|t]afs]so|[s|e]afo|s|o|a]zs]s 1 [ 3|03 [o|a]z2
1 3 ] 5 0= | L [] [ o= O 7e= O 3 [ o | L O e [ (| I o= [ 8 o [ s
2 3 O ox LS o [0 o [ "] I8 o [ o ] [ O ¢ ] [0 8% [[] &5 [ [ o [N o | L
4 2 [ o [ | L ] o I8 o [ o [ o [ o | L S o [~ ] I8 o [ o [ o [N o | L
5 3 ] "] OO se% | [ 3% [ (| O I | O ox [ o O 8% | [ 31% [[] [ o "] L o ]
8 2 [0 e3% [[] 523 O 7% [ 92 [ sex O &= [ [0 e1% [ [] 58 1 O 8% [ L1 o [ o LS o L o [ 7a
9 2 I o O ox O 7% | O 73% [ o% 18 0% [ o [ 02 I o | L O o S o= 18 o [ o [ o [N o | L
10 2 [N 0% BN o (1 73% LMo SIS o [Nox BN [ o LN o 1o ] LI ox IR o ] LN o 18 0%
13 2 [ 8s% PN o [0 7% [ O 7% | O L1 ss= L] [ o LN o 1o [ 72 L] 0% IR o 1o L1 o LN o 176
13 2 ] [N o [1 62% | [] &% | [] o [ 74 [[] o [ o [N o [ 1o []61% [ 0% L IR o [0 ] [N o [1 s
15 2 [ 8s% PN o [173% [ []73% [ [] [ ss= [[] [ o [N o [ 1o [ 72 L] 0% L IR o [0 [ o [N o [1 76
1B 3 [N o= B [N o% [N [Nox BCINox (BTN o ] [N o [ 1o [ 72 L] 0% L IR o [0 [ o [N o 1
0 2 [N o% BCINox [BCINo% BN ss% SIS e [Nox PCNox BCNox BCNox BCNo% [BCINsse BN s7s BLIRox BN ox [BLINox FLINox [BLINo
241 2 - 0% [] [ ox B[] [1hoe B ox B[1Ho% ] [1noe B[ 1Nox K] [1hox B[N ox B[ 1Ho0% N[] r ] ;"
Paper Information - »f e v
tip: Click a paper to see it's information. tip: Click a reviewer to see it's information
e | ~ @
Reviewer Freference Match Assign #P Freference Match Assign
Paper F\Iteri” Reviewer Filters || Color Information
Redock Al

Figure 5.1 Manual Distribution — Paper Assignment
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6 Assignment Validation and Saving Current Work

19. Go to the menu option ‘Validation’ and choose ‘Assignment’.

20. In the validation assignment window you can validate all paper assignments. If the current
assignment is to be reviewed by the Area Chairs then you should set all to “Temp’ by clicking
on the option “Temporary all’. Otherwise, you can validate all assignments by clicking on
‘Validate All’.

85 primoris - Canference Management System =X
File  Submit
Distribution Information Assignment Validation -
#Faper Reviewsr Distribution Type Yes No Temp
5 H. Pierreval Auto O O [ ]
9 Maoufel Cheikhrouhou Auto | "] ]
10 Peter Csaba Tlveczky Auto O (I [
13 Mikel Petty Auto O O [ ]
14 YuZhang Auto O O [ ]
15 Mikel Petty Auto O O ]
15 Shaoen Wu Auto O O ]
20 Klaus G. Troitzsch Auto O O ]
21 Giovanni Stea Auto O O ]
21 Hassan Diab Auto O O ]
23 Giovanni Stea Auto O O ]
30 Manuel Resinas Auto O O ]
33 H. Pierreval Auto O O ]
33 Mamadou Seck Auto O O L]
34 Yu Zhang Auto O O L]
37 Kiaus G. Traitzsch Auto O O [
39 Gert-Jan de Vreede Auto 0 0 [
39 Gregory Zacharewicz Auto O O [ |
22 H. Piemreval Auto || 0 L]
6 Mura Ivan Auto 0 0 [
49 C. Michael Overstreet Auto 0 0 [
50 C. Michael Overstreet Auto 0 0 [
52 Shaoen Wu Auto 0 0 [ ]
53 Adel Elmaghraby Auto O 0 [ ]
53 Shaoen Wu Auto O 0 [ ]
54 Manuel Resinas Auto O 0 [ ]
54 Nick T. Koussaulas Auto O 0 [ ]
55 Manuel Resinas Auto 1 O [ ] -
Temporary All ‘ | assing an | | unsssign an ‘ = | rm
r

Figure 6.1 Assignment Validation window

21. Save your work by choose the menu option ‘File’ and then ‘Save Original File with changes’.
22. If there are you still have assignments to change and want to return to the previous window,
then go to the menu option ‘File’ and then ‘Return to Manual Distribution’. Go to Section 5.
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7 Advanced Facilities

7.1

Paper & Reviewer Information

Everything in the Manual Distribution window is supported by the use of tooltips so that you can

have as much information as possible.

7.1.1 Details

If you want information about a specific reviewer or paper, press the respectably row / column and

the paper information frame or reviewer information frame will be updated.

By selecting a paper you will be able to access information such, Number, Title, Keywords, Authors,

Topics, Abstract and Top 5 Reviewer Match Suggestion.

By selecting a reviewer you will be able to access information such as, Name, Country,
Topics, Top 5 Paper Match Suggestion.

Email, Areas,

85! Primoris - Conference Management System - =X
Redistribute  Validation ~ Options  Help [ Motifications
Assignments - P
= S z 5 a z = z z z g z z H g =
3 8 = L g ] g ES g B 5 = g = 2 = 5 g
g - 3 £ 5 e g H z g = | s : =
#N  #R 0 4 1 4 o 4 2 3 2 3 o 5 1 4 1 5 o 5 o 0 3 0 4 1 3 1 3 0 3 o 4 2
1 3 [ 0O o 0 O o% 0O 7= O O ox [ o 1 O &% O [ s 0% [~ 1 ox [ &5
SN 0O e 0O ex [0 | 0O ex 10 ox [0 0 O ] O e [O e [0 O o= O ox [ o
4 2 0 e [0 O ] O o [0 ex [[Oex [Oox O [ 0O e 0O [0 o= O ox [0 ex [Jox [0
5 03 ] 0 O e [ e 0 0 O ] 0 e O ez [0 s [0 a1% [ O e O 0o e 0O
8 2 0O &% O s O 7= [0 O se 0O s O [ & O O O &% O m [ m [Z m [ 1 ox e
9 2 O ox [T o O =» 0O o 0% BT ox [] O O 1 ox B o m [ [ o= m [ 1 ox 1 o
10 2 O ox [T o O =» 0O m [ 0% BT ox [] O O [] O o m [ | O 1 ox 1 o
13 2 O 8% | [ o m i 0O =% O O ss= O [ O O 0O 7% O o [ ox OO ex FO00ox PN e BCO076
14 2 [] O o s 0 &% [ o0 L1 72 N7 o [] O O [] O o 1 o m [Z O 1 ox O &5
15 |2 [ 85% [ ox [ O =% 0O 0O ss= O m [ O O ] O o 1 o m [Z m [ 1 ox O 7s
B 3 O o [0 O O O o O O ex 0 O O O 7z | [ OO o« [0 ex [0 0o [0
0 2 o PO o 0 0 ss% | [0 1 o [T o m [ [ o 1 O] |55% | [ 57 1 o ]| o m [ 1 o [ 0%
12 0% ] [ 0% ] [ o o [ o3 ] (WA [ o3 ] [hox ] o [ o3 ] ] [ o™
4 i |
Paper Information ~ & ||Reviewer Information > £
Number: 1 (=) Name: Adel Elmaghraby Country: United States Email: adel@louisville.edu Bl
Title: Graph description of Soft Fault on Manufacturing Systems Areas: Methodologies and Technologies;
Top 5 Reviewer Suggestion Paper#1. = @ [Top 5 Papersuggestion - Adel Eimaghraby v
Reviewer Preference Match Assign é #p Preference Match Assign é
Claudia Frydman 1 may review this paper 8406734 % O 84 I may review this paper 8344425 % O
Durk Jouke van der Zee 1 may review this paper 83894 % O +lss Imay review this paper | 7753114 % (] -
Paper F\ItErs‘ Reviewer Filters || Color Information ‘
Redock All

Figure 7.1 Manual Distribution — Paper and Reviewer Information

7.1.2 Tooltips

On mouse-over on a reviewer you will see a tooltip showing information such as Name, Areas,

Topics and Country.
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7.2 Windows Dock & Float

It is possible to arrange the layout as you want. All frames will enter the floating mode if you double-
click them at the title bar. It is possible then to resize them, hide them, but won’t be able to close
them.
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Figure 7.5 Manual Distribution — Floating Windows

To auto rearrange the layout at the default position, you can press the ‘Redock All’ button located
at the bottom of the main window. All frames will then be rearranged to its default position.

7.3 Notifications

By activating the ‘Notifications’ checkbox you will enable desktop alerts. Desktop alerts will help
you on getting more information about what you see.

When the notifications are enabled, and if you select the papers ‘#R’ column you will get a desktop
alert.
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Figure 7.10 Manual Distribution — Notifications

7.5 Menu Color Information

The ‘Help -> Color Information’ menu allows you to change table colors.
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Imay review this paper 8311265 % ] .88 Imay review this paper 7753114 % 0 -
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Figure 7.11 Color Information menu

-

o Color Infarmatian x

Assignment Type:
Enabled Checkboxes at the grid:

LightGreen Paper Assigned

Crange Paper Automatically Assigned
Blue Paper Manually Assigned
Salmon Paper Temporarily Assigned

Reviewer's Preference at Pool of Papers:
Disabled Checkboxes at the grid:

OrangeRed Doesn't want to review the paper T
PowderBlue May review the paper -
Yellow Has a preference for the paper i
Green Wanis to review the paper

Matching between Paper and Reviewer's Topics:
Green % Match > 50%
Orange % Match > 10% and % Match <= 50%
Red % Match < 10%

Il.. ..-'I I I lI i
4

Default Calors | Confirm Changes ‘ | Discard Changes

Figure 7.12 Color Information menu

This window has all the information about the different colors used on the table, and allows you to
change any color. To do so, you must click on the dropdown list near the color and select the new
color.

For more information you can see the Reference Manual where this option is detailed (Figure 12.4).
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Figure 7.14 Color Changes Successfully Applied
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Figure 7.15 Manual Distribution window with color changes
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In this Reference Manual a description of every active item such as buttons, menus, or filters on each
Primoris — Reviewer’s Paper Assignment page is given in order to allow the Chair to check if some

required functionality is available, where it may be found and how to use the provided functionality
to achieve the task.
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8 Start Window

8! Primaris - Conference Management System

PRIQDRIS

CONFERENCE MANAGEMENT SYSTEM

‘Wark Offline ‘Wark Online

Username | Enter your Username

Choose File Password Entera

Login |

Figure 8.1 PRIMORIS - RPA Welcome window.

This window represents the welcome window of the PRIMORIS - RPA, which is divided by two
frames: Work Offline and Work Online.

In the frame ‘Work Offline’ there are two elements:

1. The ‘Choose File’ button: allows the user to choose a file with information about an
event from his personal computer.

2. The ‘Load Event’ button: allows the user to load the information in the selected event.
Note: this button is enabled after the event chooses.

In the frame ‘Work Online’ there are two elements:

1. The ‘Username’ and ‘Password’ boxes: the user fills them with their credentials to login
into the system.

2. The ‘Login’ button: used to verify the user’s credentials and access to the online work
mode.
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9 Online Work Mode

After a successfully login the user can access his user roles.

"

]
o

8 Primaris - Conference Management System T

Welcome jteixeira@insticc.org

|Choose Event

Role -

Event d yovmload

Files Awaiting for Submission

Event Mame Downloaded at Download will expire in Submit Delete

Downloaded Events

Event Mame Downloaded at Download will expire in Unlock Event

Figure 9.1 Online Work Mode window

This window contains two dropdown lists, one contains the roles that correspond to the user and
other with a list of events associated to the role selected.

NOTE: the list of events can be changed by choosing another
role.

The ‘Load Event’ button allows the user to load the information about the selected event.

NOTE: The user will be asked to save the selected event. In
case of future work with this event you won’t need to
download it again.
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B Primoris - Canference Management System

Welcome jteixeira@insticc.org

|Choose Event

Raole secretariat e

Event |ECCSS 2012 - Download |

Files Awaiting for| Information v :I
After downloading this event, you will have 3 days to submit a distribution.
Event I Otherwise this event will be unlocked. Delete
Please save your download.
OK
Downloaded Events
Event Mame Downloaded at Download will expire in Unlock Event

Figure 9.2 Save Downloaded Event

This windows also allows the user to submit an event. The user will be asked to choose a file in your

computer.

NOTE: The user will only be able to select Zipped Files (*.zip).
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[ ol Choose File Iﬁﬂ
@n\;}v|' Desktop » v|‘f|

Organize - MNew folder ¥ o+ O @

Search Desktop 0 I

- Favorites n - Libraries
R Desktop A Silvio
& Downloads = 1M Computer
£l Recent Places | € Network
EEvent.zip
.~ Libraries
3 Documents
@! Music
=] Pictures

E Videos

1M Computer
£, Local Disk (C)
5 Geral BAREADYN

-

File name: Event.zip - [Zip Files (*.zip) vl

| Open |v] | cancel |

Figure 9.3 Submit Event to PRIMORIS Database

After selecting the desired event you can press the ‘Open’ button and your file will be sent to the
PRIMORIS database.

NOTE: To send the file to PRIMORIS database it will be required
an active connection to the internet. In the case of
impossibility to send the file the user will get an error message.

When the program finishes uploading the file, the user will get an information window with ‘File
successfully uploaded’.
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10 Offline Work Mode

8! Primaris - Conference Management System =X

PR’@IDRIS

CONFERENCE MANAGEMENT SYSTEM

Work Offline Work Online
Username | Enter your Username
Choose File Password Enter a Password

[]Remember me

[ Login |

Figure 10.1 Offline Work Mode

The ‘Choose File’ button opens a window to choose a file.

NOTE: The user can only choose Zipped files (*.zip)

r B
ol Open File u
Ry
Qw 2 |£—' » Computer » Local Disk (C:) - *"7| | Search Local Disk (C:) yel |
Organize » Mew folder =« [ @
=
¥ Favorites Name Date modified Type
Bl Desktop ) Intel 28-09-2011 10:03 File folder
& Downloads E | Perflogs 14-07-2009 04:20 File folder
15| Recent Places ./ Program Files 03-10-2011 11:26 File folder
./ Program Files (x86) 04-10-201115:35 File folder
7 Libraries ) Users 03-10-2011 09:24 File folder
@ Documents ) Windows 03-10-201112:30 File folder
J’ Music |
[E=] Pictures
E Videos
L Computer
£, Local Disk (C:)
= UKRA (E) |
5 Geral (\WREADYN = | .
Edeinamme ~ | [zip Files ["ip) -
[ Open |v] ’ Cancel ]
L

Figure 10.2 Open a Local File
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PRIOIDRIS

CONFERENCE MANNAGEMENT SYSTEM

‘Wark Offline ‘Wark Online
Username | Enter your Username
Choose File Load Event Password Enter a Passward

[JRemember me

File selected: SIMULTECH2011.2ip | Login |

Figure 10.3 Loading an Event

The ‘Load Event’ button redirects to the Automatic Distribution window (Figure 11.1).
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11 Automatic Distribution

8! Primaris - Conference Management System =X

Automatic Papers Assignment

Reviews Number 2

Minimal Match (%) |30

Extra Reviews 0

Paper Type () Regular () Position (@) Regular + Position

28 Papers loaded from which
73 Regular Papers
osition Papers

wers loaded

68 Papers already distributed to 63 Reviewers.
Originating a total of 123 assignments

Exclusively Automatic Distribution Ignore Automatic Distributionand do Manual Distribution

a

w o o

Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

Figure 11.1 Automatic Distribution window

This window represents the Automatic Distribution window, which contains several elements:

1.

The information in red contains information about the event loaded:

a. Number of total papers loaded, which can be of regular or position type;

i. Number of regular papers loaded;
ii. Number of position papers loaded;
b. Number of reviewers loaded;
c. Number of papers previously distributed and the number of reviewers that
corresponded to them;

d. Number of the previously distributions;
The ‘Reviews Number’ label: allows the user to choose a minimal number of reviews for
each paper;
The ‘Minimal Match (%)’ label: allows the user to choose a minimal percentage match
between papers and reviewers;
The ‘Extra Reviews’ label: allows the user to choose a number extra of reviews to assign
to each reviewer;
The ‘Paper Type’ radio buttons: allow the user to choose which kind of papers will be
used in the distribution: Regular, Position or both;
The ‘Start Distribution’ button: allows the user to do an automatic distribution based on
the chosen values in ‘Reviews Number’, ‘Minimal Match (%)’ and ‘Extra Reviews’ labels
and ‘Paper Type’ radio buttons.
The ‘Manual Distribution’ button: allows the user to do a manual distribution based on
the results of the ‘Start Distribution” button.
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NOTE: this button is only enabled after ‘Start Distribution’
success.

8. The ‘Exclusively Manual Distribution’ button: allows the user to do a manual distribution
without the results of the ‘Start Distribution’ button.

8! Primaris - Conference Management System =X

Automatic Papers Assignment

Reviews Number 2
ed from which:
ers

Minimal Match (%) |30

210 Reviewers loaded

Extra Reviews 0 68 Papers already distributed to 63 Reviewers.

Originating a total of 123 assignments

Paper Type () Regular () Position (@) Regular + Position
Exclusively Automatic Distribution Ignore Automatic Distributionand do Manual Distribution
Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

Figure 11.2 Information after automatic paper assignment

After the distribution, it appears some information in red about it:

1. The ‘Global number of assigned Papers’: represents the global number of distributed
papers;

2. The ‘Preferential Papers assigned’: represents the number of papers that have been
assigned according to the reviewer’s preference;

3. The ‘Assigned Papers below minimum Revisions’: represents the number of papers who
has been distributed below the minimal reviews number;

4. The ‘Unassigned Papers’: represents the number of papers without any review assigned;

5. The ‘Reviewers were used’: represents the number of reviewers who has been used in
the distribution;

6. The ‘Effectiveness’: represents the distribution effectiveness;

7. The ‘Time Elapsed’: represents the time taken to distribute the papers to the reviewers.
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Automatic Papers

Reviews Number 2
98 Papers loaded from which:
79 Regular Papers
Minimal Match (%) |30 12 Position Papers

210 Reviewers loaded

Extra Reviews 0 58 Papers already distributed to 63 Reviewers.
Originating a total of 123 assignments
Paper Type (O Regular (O Position (&) Regular = Position
Exclusively Automatic Distri Ignore Automatic Distributionand do Manual Distribution

Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

82 Reviews Assigned
0 Papers Assigned according to Reviewers Preferences
0 Papers Assigned below reviews number

4 Unassigned Papers ..
18 Reviewers used Effectiveness: 100 %

Time Elapsed: 2,673 (Seconds)

Figure 11.3 Manual Distribution choose

After choosing the ‘Manual Distribution’ it will appear the Manual Distribution window based on
the results of the ‘Start Distribution’ button.
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Figure 11.4 Manual Distribution window with Automatic Assignment results
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Automatic Papers

Reviews Number 2
98 Papers loaded from which:
79 Regular Papers
Minimal Match (%) |30 12 Position Papers

210 Reviewers loaded

Extra Reviews 0 58 Papers already distributed to 63 Reviewers.
Originating a total of 123 assignments
Paper Type (O Regular (O Position (&) Regular = Position
Exclusively Automatic Distri Ignore Automatic Distributionand do Manual Distribution

Start Distribution Manual Reviews Distribution Exclusively Manual Distribution

Figure 11.5 Exclusively Manual Distribution

After choosing the ‘Exclusively Manual Distribution’ button, will appear the Manual Distribution
window without the results of the ‘Start Distribution’ button.
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Figure 11.6 Manual Distribution window without Automatic Assignment results
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12 Manual Distribution
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Figure 12.1 Manual Distribution window

This window represents the Manual Distribution window, which contains several elements:

1. The ‘Assignments’ panel: contains a table with the reviewers’ name (columns) and with
the papers’ number (lines). In addition, this table contains the reviews’ number for each
paper, and for each reviewer the number of current revisions and maximum reviews.
This table contains other relevant information such as:

a. Checkboxes with colors representing the preference level;
b. Percentage match between paper and reviewer;
c. Tooltip with:
i. Paper details
ii. Reviewer details
iii. Current Reviewers of each paper
iv. Validation type, preference match and exact match

NOTE: To do a manual assignment, the user should click on a
checkbox that the paper is assigned to the reviewer.

2. The ‘Paper Information’ panel: contains the details of the paper;
3. The ‘Reviewer Information’ panel: contains the details of the reviewer;
4. The ‘Search Filters’ panel: contains the search options for paper or reviewer:
a. Paper Search
i. The ‘Search Paper’ label: allows the user to enter the text to be
searched;
ii. The ‘Search’ button: allows the user to perform the search;
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6.

iii. The ‘Clear’ button: allows the user to clear the paper search;
b. Reviewer Search
i. The ‘Search Paper’ label: allows the user to enter the text to be
searched;
ii. The ‘Search’ button: allows the user to perform the search;
iii. The ‘Clear’ button: allows the user to clear the reviewer search;
The ‘Paper Filters’ panel: contains the search paper filters with some options:
a. ‘Topics’: corresponds to the filters based on the papers’ topics;

NOTE: if the paper has areas, the filters will be based on the
papers’ areas.

b. ‘Number Reviews Assigned’: corresponds to filters based on the number of
review for each paper, namely zero, one, two, three, four and four or more:
i. The ‘0’ checkbox: allows refreshing the table with the papers with zero
reviews;
ii. The ‘1’ checkbox: allows refreshing the table with the papers with one
review;
iii. The ‘2’ checkbox: allows refreshing the table with the papers with two
reviews;
iv. The ‘3’ checkbox: allows refreshing the table with the papers with three
reviews;
v. The ‘4’ checkbox: allows refreshing the table with the papers with four
reviews;
vi. The ‘4+' checkbox: allows refreshing the table with the papers with four
or more reviews.
c. The match label contains two elements:
i. ‘% Match’ label: allows the user to enter a percentage match to be used
in the match filter;
ii. ‘Apply Match’ checkbox: allows the user to do a match filter on a paper
or reviewer;

NOTE 1: despite of this label is in ‘Paper Filters’ panel, the filter
match can be also applied on reviewers.

NOTE 2: to do this filter it is necessary to click on a paper
number or on a reviewer name.

The ‘Reviewer Filters’ panel: contains the search reviewer filters with the following
options:
a. ‘Area’ corresponds to filters based on the reviewers’ areas;

NOTE: if the reviewer hasn’t areas, the filters will be based on
the reviewers’ topics.

b. ‘Reviews Assigned’ corresponds to filters based on the number of revisions of
each reviewer, namely No Reviews, With Reviews or Max Reviews Reached.:
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i. The ‘No Reviews’ checkbox: allows refreshing the table with the
reviewers with no reviews;
ii. The ‘With Reviews’ checkbox: allows refreshing the table with the
reviewers with reviews between zero and their max revisions number;
iii. The ‘Max Reviews Reached’ checkbox: allows refreshing the table with
the reviewers who has been their max revisions number.

NOTE: the user can apply paper filters and reviewer filters
together.

7. The ‘Redistribute -> Automatic Redistribution’” menu: allows the user to perform an
automatic redistribution
8. The ‘Validation -> Assignment’ menu: allows the user to validate the distribution.
9. The ‘Help’ menu: contains two submenus:
a. ‘Color Information’ menu: allows the user to change the table colors;
b. ‘Notifications’ menu: shows the information about notifications option to the
user;
10. The ‘Notifications’ checkbox: allows to enabled or disabled desktop alerts
a. |If the user clicks on a paper number, a notification appears with a top 5
reviewers ordered by preferential match
b. If the user clicks on the paper reviews, a notification appears with the current
reviewers assigned
c. If the user clicks on a reviewer name, a notifications appears with a top 5 papers
ordered by preferential match and current papers assigned
11. The ‘Redock All' button: allows to return to the original panels’.
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@l 'S ]

Start Distribution IManual Reviews Distribution

Automatic Papers Assignment

Reviews Mumber  H

Minimal Match (3} |30

Extra Reviews 0

Paper Type (O Reguiar () Position  (8) Regular + Position

Figure 12.2 Automatic Redistribution window

This is the ‘Automatic Redistribution” window. Which has the same information as the ‘Automatic
Distribution’ superior panel (see Figure 11.1).

-

a5 Color Information x
Assignment Type:
Enabled Checkboxes at the grid:
LightGreen Paper Assigned ¥
Orange Paper Automatically Assigned -
Blue Paper Manually Assigned - 3

Salmon Paper Temporarily Assigned

Reviewer's Preference at Pool of Papers:
Disabled Checkboxes at the grid:

CrangeRed Doesn't want to review the paper i
PowderBlue May review the paper -
Yellow Has a preference for the paper &
Green Wants to review the paper

Matching between Paper and Reviewer's Topics:

4

Green % Match = 30% ¥
Orange % Match > 10% and % Match <= 50% -
Red % Match < 10% =
Default Calors | Confirm Changes ‘ | Discard Changes

Figure 12.3 Color Information menu

After choosing the ‘Help -> Color Information’ menu, will appear a window with the information
regarding the table colors. This window contains the following elements:

1. The ‘Enabled Checkboxes at the grid’ group: corresponds to the colors of the enabled
checkboxes. Has three distribution types:
a. Paper Pre-Distributed
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b. Paper Assigned Automatically
c. Paper Assigned through Hand Distribution
2. The ‘Remain Colors -> Disabled Checkboxes at the grid’ group: corresponds to the colors
of the disabled checkboxes based on the reviewers’ preference. Has four preference
levels:
a. ‘Doesn’t wish to review the paper’
b. ‘Reviewer may review the paper’
c. ‘Reviewer has a preference for the paper’
d. ‘Reviewer wants to review the paper’
3. The ‘Percentage Colors’ group: corresponds to three levels of preference match.
a. ‘% Match >50%’
b. ‘% Match > 10% and % Match <= 50%’
c. ‘% Match < 10%’

NOTE: next to each color there is a dropdown list that allows
the user to change the color that he wants (Figures Figure 12.4,
Figure 12.5 and Figure 12.6 ).

4. The ‘Confirm Changes’ button: allows the user to confirm the color changes.
5. The ‘Default Colors’ button: allows the user to restore the default table colors.

85 Color Infarmatian x

Assignment Type:
Enabled Checkboxes at the grid:

DarkCyan Paper Assigned - DarlCyar| T
Orange Paper Automatically Assigned -
Blue Paper Manually Assigned - -

Salmon Paper Temporarily Assigned

Reviewer's Preference at Pool of Papers:
Disabled Checkboxes at the grid:

OrangeRed Doesn't want to review the paper i
PowderBlue May review the paper -
Yellow Has a preference for the paper -
Green Wanis to review the paper

Matching between Paper and Reviewer's Topics:

Green % Match > 50% T
Crange % Match > 10% and % Match <= 50% -
Red % Match < 10% =
| Default Calors | | Confirm Changes | Discard Changes !

Figure 12.4 Table Color Changes

If you click on a dropdown list, you will see a palette of all available colors.
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Figure 12.5 Color Changes successfully applied
After doing color changes the system will inform the user.
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Figure 12.6 Manual Distribution window with color changes

The assignments table is then refreshed accordingly.
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13 Assignment Validation

o5l primaoris - Conference Management System - B X
File  Submit
Distribution Information Assignment Validation il
#Paper Reviewer Distribution Type Yes No Temp
9 H. Pierreval Auto O O L]
9 Maoufel Cheikhrauhou Auto O O L]
10 Peter Csaba Tlveczky Auto O O L]
13 Mike! Petty Auto 0 O [
14 Yu Zhang Auto || 0 [
15 Mike! Petty Auto 0 O [
15 Shaoen Wu Auto 0 O [
20 Kiaus G. Traitzsch Auto 0 O [
2 Giovanni Stea Auto 0 O [ ]
2 Hassan Diab Auto O O [ ]
23 Giovanni Stea Auto O O [ ]
30 Manuel Resinas Auto O O [ ]
33 H. Pierreval Auto O O [ ]
33 Mamadou Seck Auto O O [ ]
34 YuZhang Auto O 0 [ ]
37 Kiaus G. Traitzsch Auto 0 O [
39 Gert-Jan de Vreede Auto 0 O [
39 Gregory Zacharewicz Auto O O []
42 H. Pierreval Auto O O [
46 Mura Ivan Auto O O [
4 €. Michael Overstract Auto O 0O ]
50 €. Michael Overstract Auto O 0O ]
52 Shaoen Wu Auto O O [
53 Adel Eimaghraby Auto O O [
53 Shaoen Wu Auto O O [
54 Manuel Resinas Auto O O [
54 Mick T. Koussoulas Auto O O [
55 Manuel Resinas Auto O O =] =
Temporary All | | Assing il | | unassign Al F r‘“’
r

Figure 13.1 Assignment Validation window

After choosing the ‘Validation -> Assignment’ menu in Manual Distribution window, will appear the
‘Assignment Validation’ window. This window has a table with two principal columns:

1. ‘Distribution Information’ column, has two sub-columns with information about:
a. Paper number
b. Reviewer name

NOTE: if the user moves the mouse to a paper number, it will
show a tooltip with the paper details. If the mouse is moved
over a reviewer name, it will show a tooltip with the reviewer
details.

2. ‘Assignment Validation’ column, has four sub-columns with information about:
a. Distribution Type: ‘Auto’ or ‘Manual’;
b. Three validation types
i. The ‘Yes’ checkbox: allows the user to validate the selected Assignment
ii. The ‘No’ checkbox: allows the user to invalidate the selected Assignment
iii. The ‘Temp’ checkbox: allows the user to set the paper temporally to the
selected reviewer

At the bottom there are 2 checkboxes:

1. The ‘Temporary All’ checkbox: allows the user to set all papers as temporally assigned;
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2.

The ‘Validate All’ checkbox: allows the user to validate all Assignments.

And two menus:

1. The ‘File’ menu, with two sub-menus:

2.

a. The ‘Save Original File with changes’ menu: allows the user to save to file all

changes;

b. The ‘Return to Manual Distribution’ menu: allows the user to return to Manual

Distribution window (Figure 12.1).
The ‘Export to Database’ menu, with two sub-menus:

a. The ‘Export’ menu: allows the user to submit the event to the PRIMORIS

database;

b. The ‘Save Assignments for later Submission’ menu: allows the user to save the

current work, to a file, for later submission.

[

a5l Save File — @
4 £, » Computer » Local Disk (C)) » v | %2 || Search Local Disk (C: ol
i) | » Comp ?
Organize « Mew faolder Heciiae l@l
B Desktop 2 Name Date modified Type
4 Downloads s e
< L J Intel 28-09-2011 10:03 File folder
2| Recent Places |5 | S "
i Perflogs 14-07-2009 04:20 File folder
o | Program Files 07-10-2011 09:47 File folder
=l Libraries : e
= Program Files (x86) 04-10-2011 15:35 File folder
<| Documents NS )
o ] Users 03-10-2011 09:24 File folder
a! Music ; ey = :
. Windows 03-10-201112:30 File folder
k= Pictures
B videos
M Computer
&, Local Disk (C:)
- UKRA (E)
53 Geral (WREADYM ~ 4 [ i '
File name:  myfFile =
Save as type: | Zip Files (".zip) v]
= Hide Folders Save ] | Cancel J

Figure 13.2 Save Original File with changes

After choosing the ‘File -> Save Original File with changes’ menu, will appear a window that allows

saving the event to the user personal computer. After having the work successfully saved, a

notification will appear.
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| 85 Primoris - Conference Management System -
Submit Validated Assignments ation |
| Faies R = Reviewer | i ion Type

T FPlerreval Auto

9 Maoufel Cheikhrauhou Auto

10 Peter Csaba Flveczky Auto

13 Mikel Petty Auto

1 Yu Zhang Auto

15 Mikel Petty Auto

15 ShaoenWu Auto

20 Kiaus G. Traitzsch Auto

21 Giovanni Stea Auto

21 Hassan Diab Auto

3 Giovanni Stea Auto

0 Manuel Resinas Auto

33 H. Pierreval Auto

33 Mamadou Seck Auto

34 Yu Zhang Auto

37 Kiaus G. Troitzsch Auto

39 Gert-lan de Vreede Auto

39 Gregory Zacharewicz Auto

42 H. Pierreval Auto
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5 Sraceni r 2 o o
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Figure 13.3 Export to Database menu

Username |Enter your Username |

Password |Entera Password |

Login ] [ Submit File l

Figure 13.4 Authentication window

In the ‘Export to Database -> Export’ menu, an authentication window will appear.

Username |jteixeira@instin:.urg |

Password | |
Login Successfull jteixeira@insticcorg

Login | Submitfile

Figure 13.5 Submit Event option
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After a successful login, the ‘Submit File’ button is enabled and the ‘Login’ button is disabled.

NOTE: if the user is already authenticated, then it will not be
necessary to do it again. In this case the ‘Submit File’ button is
enabled and the ‘Login’ button is disabled.
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Figure 13.6 Save Assignments for Later Submission option

After choosing the ‘Export to Database -> Save Assignments for later Submission’ menu, the user
can save the event for later submission.
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14 Known Issues

14.1 Multiple Reviewers Selection

Reviewers can be selected by the clicking on their

14.1).

names

with any of the mouse buttons (Figure
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To unselect a reviewer, you must right-click it (Figure 14.2), and it will be unselected.
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NOTE: This issue will be fixed in the next release.
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Glossary

Position Paper

Regular Paper

A position paper presents an arguable opinion about an issue. The goal of a
Position Paper is to convince the audience that your opinion is valid and
worthy to listen to, without needing to present completed research work
and/or validated results. However, it is important to support your argument
with evidence to ensure the validity of your claims. A Position Paper may be a
short report and discussion of ideas, facts, situations, methods, procedures or
results of scientific research (bibliographic, experimental, theoretical, or other)
focused on one of the conference topic areas. The acceptance of a Position
Paper is restricted to the categories of ‘short paper’ or ‘poster’, i.e. a Position
Paper is not a candidate to acceptance as ‘full paper’.

A regular paper presents a work where the research is almost or completely
finished. It does not necessarily mean that the acceptance is as a full paper. It
may be accepted as a ‘full paper’ (30 min. oral presentation), a ‘short paper’
(20 min. oral presentation) or a ‘poster’.
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